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1. Requirements and Guidelines for Completing Graduate Theses and

Dissertations

The following are general ESF requirements and guidelines for preparing and submitting theses 

and dissertations. Individual departments may have additional requirements. The student should 

consult with their department and/or major professor regarding these specific guidelines.  

Document Style: 

Document styles may vary but must be applied consistently throughout theses and dissertations. 

The general style manual for the college is the Council of Science Editors Style Manual (latest 

edition), available in the reference area of Moon Library and at the Reference Desk of Bird 

Library. Quick reference guidelines can be found in the embedded link. A department may opt to 

use a style manual that is more discipline-oriented. 

Department Formatting:  

In opting to use a specific style manual, the department accepts the responsibility of 

communicating this preference along with any other special requirements to the graduate 

students concerned. It is the student's responsibility to be aware of the style manual and any 

special requirements of the department and to have the prior approval of the student's major 

professor and steering committee concerning the guidelines adopted. Students should be sure to 

use this style during document preparation. Theses and dissertations will be acceptable as first 

determined by individual departments.  

Digital Commons: 

The college now participates in electronic archiving through the Moon Library called Digital 

Commons. The submission of your graduate thesis/dissertation to Moon Library's Digital 

Commons repository will open your work to the world, if you allow availability. The Digital 

Commons is fully Google-searchable and provides open access to your work, allowing anyone to 

download and make non-commercial use of it. Electronic theses and dissertations draw hundreds 

of downloads from repositories every month. Prospective employers have been known to use 

electronic theses and dissertations to scout new potential hires. For these reasons it is vital that 

you ensure that the work you provide is the final version, ready to be shared with the world. 

In order to give the Digital Commons a non-exclusive right to reproduce and distribute in 

electronic format via the World Wide Web, students must authorize this when uploading their 

documents. Students also have the option of restricting access in the permanent digital archive to 

local access only (available to ESF students/faculty/staff). 

https://www.wsc.edu/download/downloads/id/1858/council_of_science_editors_cse_style_examples_-_8th_edition.pdf
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2. Formatting the Thesis or Dissertation- Sequencing of Pages

Font- Font should be the same size, color, and style throughout the entire document (including 

chapter and page headers). 

Pagination 

1) Front matter- Roman numerals (lower case) should be used consecutively for all pages

preceding the document body (for example, i, ii, iii, iv, v, vi, etc.). Please note that while

the Title Page and Copyright page do count toward the running total, numerals do not

appear on these pages.

2) Body & Chapters/Main Division of the Body- Arabic numerals should be used

consecutively for all pages of the main document, typically beginning with the first page

of Chapter 1. Switching to Arabic numbering, the numbering begins with 1 and runs

consecutively to the last page of the paper- (i.e. 1,2,3, etc.); a page number must appear

on the final page if there is any substantive text. See example on page 17.

Reference this helpful video for tips on breaking up pages and page number conventions in 

Microsoft Word, but do not follow the formatting suggested by the video: 

https://youtu.be/I51qr77PVwc?t=207 

Front Matter- Front matter includes the “preliminary” parts of the thesis or dissertation, 

including the Title Page, Copyright, Table of Contents, Lists of Tables and Figures, Abstract, etc. 

The following suggests formatting for typical front matter pages included in theses and 

dissertations at ESF:  

1) Title Page- The student is considered the author of any thesis or dissertation and as such only

the student's name shall appear on the title page along with the following names to be typed

below the degree program for easy identification and future reference.

1) the Major Professor (or co-Major Professors, where applicable)

2) the Department Chairperson or Graduate Coordinator

3) the Chair of the Examining Committee

4) Dean of the Graduate School.

The date listed on the title page should be the month and year in which the document was 

successfully defended. For example, if the defense is April 12, 2021, the date on the title page 

should be “April 2021.” See sample format on page 9.  

2) Copyright (optional)- The Copyright Act of 1989 does not require that published works carry

a copyright notice in order to secure copyright protection. See sample format on page 10.

3) Acknowledgements (optional)- When the author feels that acknowledgements are necessary,

it should be remembered that brevity is a virtue. Section appears after Title Page and/or

Copyright.

https://youtu.be/I51qr77PVwc?t=207
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4) Table of Contents- The Table of Contents should not reference the content on any pages

preceding it (i.e., title page, copyright notice, acknowledgments). Table of Content titles should

be limited to one sentence in length, and not multi-sentence. The wording of the chapter titles and

all subheadings should exactly follow the wording within the body of the paper. Omit underlining

in the Table of Contents. Period leaders between headings and page numbers should be used. All

page numbers must be aligned to the right of the page. Set up Table of Contents using Word to

ensure alignment and proper page numbering. See sample format on page 12.

5) List of Tables- Following the Table of Contents, the List of Tables should follow the exact

wording within the body of the paper. Table titles should be limited to one sentence. Omit

underlining in the List of Tables. Period leaders between headings and page numbers should be

used. The List of Tables and List of Figures should be on separate pages. See sample format on

page 14.

6) List of Figures- Following the List of Tables, the List of Figures should follow the exact

wording within the body of the paper. Titles should be limited to one sentence in length, and not

multi-sentence. Omit underlining in the List of Tables. Period leaders between headings and page

numbers should be used.

7) List of Appendices- Following the List of Figures, the wording of the List of Appendices

should follow the exact wording within the body of the paper. Omit underlining in the List of

Appendices. Period leaders between headings and page numbers should be used. A List of

Appendices is only appropriate when the document contains multiple appendices.

8) Abstract with Key Words- The abstract is the last page paginated with Roman numerals. The

abstract summarizes a thesis or dissertation. The abstract page is required and will contain key

words listed a few lines below the abstract. Abstracts are bound with the document and are not to

exceed 150 words for a master's thesis, or 350 words for a doctoral dissertation. The abstract date

and month should be the same as the defense date in the Title Page.

If the thesis or dissertation is divided into manuscript style, the main abstract should be inclusive 

of all manuscript content included in the document. Each manuscript may include its own 

abstract, without a particular word limit. Likewise, the conclusion section should be a synthesis 

of all included manuscripts. See sample on page 16. 

Thesis/Dissertation Body- The “body” is composed of the various chapters of text. 

Components- The following are traditional components of the body of a thesis or dissertation at 

ESF:  

1) Introduction

2) Literature Review

3) Models and Materials

4) Results

5) Discussion

6) Conclusions
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Chapters or Main Division of the Body - For the chapters and the remainder of the manuscript, 

including text, charts, illustrations, appendices, bibliography, vita, etc., use Arabic numerals 

(1,2,3, etc.). Each page must be consecutively numbered in the bottom right-hand margin at the 

foot of the page. Do not use letter suffixes such as 10a, 10b.  

Back Matter- “back matter” is the material following and supporting the main body or text of 

the thesis or dissertation. Pagination for the back matter remains in sequence and style with the 

body using Arabic numerals. Arabic page numbering continues consecutively from the Body 

through the Back Matter section. Following are traditional components of the back matter to be 

included in theses or dissertations at ESF:  

Reference list or Bibliography 

Appendices  

Resume or Vita (This is the last page of the document and should include 

the last Arabic page number)  

3. Bibliography or References

The Graduate School recommends that students follow the standard citation format used for the 

journal publications in the student's field of study. The format must be consistent throughout the 

manuscript and placement of the bibliography or references should come at the end of the 

manuscript. Students may also opt to use the Council of Science Editors (CSE) style guide to 

format their references. Following are some examples of references in the name-year sequence of 

the CSE style guide. Please refer to the CSE style guide found in Moon Library for more 

information. 

4. Graduate School Review & Submitting your Electronic Thesis or

Dissertation

Students must submit draft documents of the thesis or dissertation electronically to 

esfgrad@esf.edu for format review at least two weeks prior to the semester deadline for 

submission. The Assistant Dean or a graduate assistant will review what you submit and provide 

feedback concerning the formatting. Documents containing a significant number of formatting 

errors may be returned to the author for corrections prior to further review.  Only the format will 

be reviewed - not the contents of the complete document. If you do not hear back from the 

Graduate School, do not assume everything is correct. Check with the office before you submit 

your final copy.  

Once the document has been reviewed for formatting errors and approved by the defense 

committee for submission, final theses/dissertations should be uploaded to Google Forms for 

transfer to the Digital Commons: https://forms.gle/qe1d4fVYZacVoCra6. If you do not have a 

Google account, you can access your SU Google account by using your personal 
NetID@g.syr.edu and your SU password. For more information on accessing your google 
account, see page 8.

https://www.google.com/url?q=https://forms.gle/qe1d4fVYZacVoCra6&sa=D&source=editors&ust=1663177134330964&usg=AOvVaw3ppqio_OLwFCtRVjK1Ub5H
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Students should get the “Final Thesis/Dissertation Approval Form” also known as the Form 8a 

(see Attachment A) signed by all listed members on the Title Page and turn it into the Graduate 

School, at 227 Bray Hall or esfgrad@esf.edu before the final deadline (typically the Friday 

before the next semester’s classes begin). Students in the Division of Engineering must also 

obtain the signature of the Director of the Division of Engineering on the Final 

Thesis/Dissertation Submittal Form (8a).  

Finally, students must pay their Thesis Processing Fee to the Cashier and turn in the Graduation 

and Key Return Form. These forms are located in Attachment B on page 19 and Attachment C 
on page 20. Electronic copies of the forms are also found at https://www.esf.edu/graduate/.

Personal Copies/Bindery: 

If you wish to have personal copies bound, we found a bindery in Rochester, NY. You will have 

to upload a PDF of the document. Please note this is not an endorsement of this bindery, but 

simply the name of a bindery that might produce single copies: Book1One at 

https://www.book1one.com/ in Rochester.  

Please Note: The Department of Landscape Architecture requires students to include the 

following disclaimer in all theses: ‘The ideas and opinions expressed in this publication are 

those of the author and should not be interpreted as those of the State University of New York 

College of Environmental Science and Forestry.’ 

6. Manuscript Format or Other Type of Style Guide (approved by individual

departments)

The “Title Page” should remain unnumbered, and all the rest of the front matter (i.e. the pages 

following the Title Page, and ending with the Abstract) should be numbered in lower-case 

Roman numerals, starting with “ii" at the bottom right-hand margin. The front matter should be 

ordered as shown below, so that the Abstract is the last page numbered with lower-case Roman 

numerals. The page following the Abstract, which is the first page of the body of the document 

(Chapter 1/Introduction), should start with page ”1” and Arabic numerals should run thereafter 

until the last page of the student’s vita at the very end of the document. Identify the name of the 

style guide on the Abstract page. 

Front Matter: Title page 

Acknowledgments 

Table of Contents  

Abstract  

Body: Introduction 

Manuscripts 

Conclusions  

Back Matter: Literature Cited 

Appendices  

Vita or Resume 

https://www.esf.edu/graduate/
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Students must submit a vita or resume (See sample on page 17) as the last page of the thesis or 

dissertation. It is the student's responsibility to ensure that components of all submitted 

documents are in the correct order, with all pages included.  

7. Logging into Your Syracuse Google Account

You may not think you have one, but if you are an ESF student, you do. 

Use the following link for instructions on how to log into your Google account: 

https://ols.syr.edu/google-account-for-syracuse-university/ 

Once logged into your syr.edu google account, you should be able to use all of Google 

applications, including the Google Forms for uploading your thesis/dissertation. 

https://ols.syr.edu/google-account-for-syracuse-university/
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Sample Title Page 
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Sample Acknowledgements Page 

 

 

 

 

 

 

 

 

Proper format and order for Acknowledgements Page.  First page where a page number appears, 

with the number system accounting for the Title and Copyright Pages. 
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Sample Table of Contents 
Proper format for a Table of Contents, listing only the sections of the document that appear 

AFTER the Table of Contents (i.e., omitting the Acknowledgements, Copyright, and Table of 

Contents).  The Table of Contents should be formatted in Word, with page numbers aligned to 

the right and page leaders between the headings and page numbers.  See the following page for 

instructions on constructing a Table of Contents in Word 2007. 
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CHAPTER 4: CONCLUSIONS ................................................................................... 94 
VALUE OF COMBINED METHODS ....................................................................... 94 
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RESUME………….…............................................................................................. 124
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8. Setting up Table of Contents 

 

A Table of Contents can be constructed in Word based on a pre-existing document with headings 

and subheadings.  Insert the curser at the start of the document, or where you intend the Table of 

Contents to appear.  In Word 2007, navigate to the References tab, select Table of Contents, 

Automatic Table 2.  This will insert a blank Table of Contents, as seen below. 

 

 

 

 

 

Next, select content to add to the table by highlighting 

various headers and using “Add Text” under the 

References tab.  Here, you can define the levels of text, 

which corresponds to the indentation and order in the 

Table of Contents.  You will have to “Update Table” 

after you “Add Text.” 

 

 

Word will typically reformat your document text once 

you “Add Text.” You can either reformat the text 

within the document, or reformat the style for the 

document under Home tab, Styles, then select each 

layer of text (e.g., TOC 1, TOC2, TOC3, etc.) and 

select Modify.  Here, you can set the text to a specific 

color, size, or format (bold, italics, capitalized).  You 

can also edit text appearance within the Table of 

Contents.   

 

Each time you Add Text to the table, or change the 

page location of a heading, you will need to update the 

table by clicking on the Table of Contents.  

 

 

 

 

 

For more information on setting up a table of contents, visit: 

http://cybertext.wordpress.com/2010/07/23/word-2007-create-an-automatic-table-of-contents/  

 

 

 

 

 

 

 

http://cybertext.wordpress.com/2010/07/23/word-2007-create-an-automatic-table-of-contents/
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9. Setting up List of Figures/List of Tables 

Formatting a List of Figures and List of Tables is a similar process, but through different options 

in Word 2007. 

 

First, you must designate the number and 

description of each table/figure as a Caption.  

Select the table or figure then under the 

References tab, select Insert Caption.  In the 

space provided, enter the description of the table 

or figure.   It is likely that Word 2007 will 

reformat your text, but you can define the format 

within the Home tab, styles, captions, then 

modify.  

 

To organize tables/figures by chapters, you can 

either use a precise numeric or you can create 

new, specific labels for the tables and figures of 

each chapter within Insert Caption.  You should 

create captions before you insert the Lists.  Once 

you have entered all the captions, you can create 

Lists for Tables and then Figures, or organize 

each of those lists by chapters.   

 

Tables are updated by selecting Update Table 

from the Captions section on the References tab.  

A similar List can be created for Appendices, if 

the end of your document contains multiple 

Appendices.  The List of Tables, List of Figures, 

and optional List of Appendices are the first 

items to appear in the Table of Contents.  

Throughout all tables, remove any optional 

hyperlinks and use page leaders 

 

For more information, visit: 

http://www.brighthub.com/computing/windows-platform/articles/26635.aspx 

 

http://www.brighthub.com/computing/windows-platform/articles/26635.aspx
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Sample List of Tables Organized by Chapter 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

The List of Figures and List of Appendices are both similar. 

 

 

Note: For these lists please only include the label ("Table 1") and a short title, not a full multi-

sentence caption. Unfortunately, Word's "autocaption" option for lists of tables and figures inputs 

the entire multi-sentence caption, so you may need to directly edit the lists after they have been 

generated to remove any extra sentences. 

 

  

LIST OF TABLES 
Chapter 2   
Table 1: Adirondack community characteristics …………………………………………………………….... 29 
Table 2: Summary of survey efforts ………………………………………………………………………………….. 32 
Table 3: Scale items representing wilderness attributes …………………………………………………… 36 
Table 4: Summary of surveys collected by sample group ……………………………………………….. 38 
Table 5: Survey respondent distribution among U.S. States ………………………………………….… 38 
Table 6: Comparison of mean demographics …………………………………………………………………… 43 
Table 7: Desirability of scale items ………………………………………………………………………………..… 44 
Chapter 3   
Table 1: Data files used to represent survey items …………………………………………………….…… 67 
Table 2: Buffer distances (km) for undesirable items ……………………………………………….……. 70 
Table 3: Percent of layer total area out of Adirondack Park total area …………………….……… 78 
Table 4: Overlap between areas perceived as wilderness and APA designations …..………….. 80 
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Sample Abstract Page 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Abstract 
 
 
S.H.Velardi. An Exploration Into the Components of Effective Professional Development 
for Science Educators: A Case Study with the Environmental Education Project Learning 
Tree, 134 pages,11 tables, 22 figures, 2011.  APA style guide used.  
 
 
 
Wilderness can be understood via individual perceptions that may contrast with legal 
definitions. This contrast was explored within the Adirondack Park (NY), a unique 
combination of land uses and stakeholders with a history of conflict over policies that 
restricted development to conserve natural resources. This research used wilderness 
perception mapping (WPM) to identify differences between perceived and legal 
wilderness in the Adirondacks, based on the desirability of landscape characteristics 
(e.g., maintained campsites) reported by questionnaires. I used this approach to gain 
insights on differences among stakeholders and communities, and to construct maps of 
wilderness perceptions to compare with existing land use classifications. Survey and 
map analyses indicated clear differences among stakeholders, particularly between 
residents and non-residents, and between legally designated and perceived wilderness 
areas. These insights contribute to a greater understanding of diverse stakeholder 
groups and improved management of the Adirondack Park landscape and natural 
resources. 
 
 
 
 
 
 
 
 
 
 
 
 
Key Words: stakeholder groups, Adirondack communities, purism scale, geographic 
information systems. 
 
 
 
 
 
 
 
 
 
 
 
S.H.Velardi 
Candidate for the degree of Master of Science, May 2014 
Elizabeth Folta, Ph.D. 
Department of Environmental and Forest Biology 
State University of New York College of Environmental Science and Forestry, 
Syracuse, New York 
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Use first and 

middle 

initial plus 

last name 

The maximum acceptable length for an abstract to be published in Master’s Thesis 

Directories is 150 words, and the maximum acceptable length for a dissertation to be 

published is 350 words.  ProQuest will only accept the online submission of abstracts at 

this word maximum, and will omit any additional words.  It is in your best interest to 

maintain this maximum.  You can prepare more lengthy abstracts within each document 

chapter.   

 

Month and year of defense. Should 

match the date printed on the title 

page. 

 

Print title exactly as it appears on title page, using Initial Caps.  Use the 

total number of pages, tables, and figures of the document as well as the 

year the document was defended (not the year of graduation, if there is a 

difference) 

 

For Co-major professors, list both names  

Type of style 

guide used 
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This section begins with page number 1, with subsequent page numbers running in sequence 

throughout the remaining document.  The final page of the document must contain the student’s 

resume or Vita.  Students can either include the current version of their resume or Vita, or can 

follow the formatting guide provided  

below.  

Sample vita or Resume Page 

 

 

 

 

 

 

 

 

 

  

CHAPTER 1: INTRODUCTION 
 
OVERVIEW 
 
Wilderness designation and preservation is based on current legal policy that 
defines the wilderness concept. An alternative understanding of wilderness can be 
gained via individual or cultural perceptions. The Adirondack State Park of New York 
provides an ideal environment for the study of wilderness perceptions, with a six million 
acre mixed landscape of public and private lands and a history of conflict between 
residents and nonresidents over the use of Adirondack lands and resources. 
Wilderness perception research in the Adirondack Park could improve the 
understanding of differences among stakeholders and assist managers and policymakers 
seeking to balance conservation and development in this unique wilderness 
landscape. 

Name 

Date and Place of Birth 

Education 

  Name and Location  Dates  Degree 

High School: 

College: 

Graduate School: 

 

Employment 

  Employer   Dates  Job Title 

 

 

nth page number 
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10. Final Thesis/Dissertation Approval Form    (Attachment A) 

                                                            
        Form 8a  

    

Final Thesis/Dissertation Approval Form 

 

 

  
Name of Student:__________________________________ SU ID________________________  

 

Title of Thesis/Dissertation: _______________________________________________________ 

_______________________________________________________________________________  

 

_______________________________________________________________________________  

 

Total number of pages (including tile page, front matter, chapters, and vita or resume)___________  

 

The above named thesis/dissertation has been approved, including the abstract page, in partial 

fulfillment of the requirements for the Master of Science/Doctor of Philosophy Degree, State 

University of New York, College of Environmental Science and Forestry, Syracuse, New York.  

_________________________          _________________________________ 

 Month and year of Defense           Name of Department or Program 

 

 

 

Approved by:   

 

  
_______________________________             __________________________________  

Chair, Examining Committee    Major Professor  

 

______________________________               __________________________________ 

 Co-Major Professor (if applicable)   Department Chair  

 

_________________________________  

Dr. Gary Scott, Engineering 

(if applicable)  

 

 

 

Return form to the Graduate School, 227 Bray Hall, 1 Forestry Drive, Syracuse, New York 13210 

The Graduate School 102217 
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11. Thesis Processing Fee Form      (Attachment B) 

 

                                                 

Thesis Processing Fee 

 
Date:______________________________ 

 

Student Name:_______________________________________ SU ID#______________________ 

 

Academic Department:_____________________________ Semester/Year_____________________ 

 

A $35 mandatory processing fee is required at the time your electronic thesis/dissertation is 

submitted to the Graduate School. All fees are payable to the Cashier in 102 Bray Hall with 

checks payable to “SUNY ESF” or with a credit card. Return this form, including cashier 

endorsement below, to the Graduate School in 227 Bray Hall as evidence that you paid.  

 

 

 

 

 

 

 

 

 

 

 

 

Return completed form to the Graduate School, 227 Bray Hall, 1 Forestry Drive, Syracuse, New York 13210 

 

 

To be completed by cashier:  

Receipt number: ________________ 900580-00; GL#33800.19 

 Thesis Processing Fee sheet updated: 10/2/17 
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12.  Graduation and Key Return Form     (Attachment C) 

SUNY COLLEGE OF ENVIRONMENTAL SCIENCE AND FORESTRY 
Graduation and Key Return Form 

 

NAME _______________________________________________________________________ 

  (PRINT CLEARLY your name as you wish it to appear on your diploma) 

SU ID # ______________________________________________________________________ 

DEGREE LEVEL_____________________ CURRICULUM ___________________________ 

EXPECTED DATE OF GRADUATION:    December ______  May _______  August ________ 

 

Keys returned (University Police signature required or attach receipt): 

University Police ________________________________________ Date ____________ 

If continuing at ESF (and not returning keys), major professor or supervisor signature:  

 

 Major Professor _________________________________________ Date ____________ 

 

ADDRESS WHERE DIPLOMA WILL  

BE MAILED:    __________________________________________ 

Diplomas are mailed after graduation.  __________________________________________ 

This address should be one which will __________________________________________ 

not change for at least 6 months after  __________________________________________ 

graduation.     __________________________________________ 

       

 

PERMANENT MAILING ADDRESS: __________________________________________ 

List here an address through which mail __________________________________________ 

will always reach you.  If this address is __________________________________________ 

the same as above, write “same.”  __________________________________________ 

       

Date this form was completed:  __________________________________________ 

 

 

OFFICE RECORD – CANDIDATES SHOULD NOT WRITE BELOW THIS LINE. 

Diploma ordered _________________________________  Date graduated _________________ 

Diploma received_________________________________ Diploma sent ___________________ 

Commencement fee paid ___________________________ 

DIPLOMA COVER PICKED UP: _______________________________________________ 

 

 

 
Return completed form to the Graduate School, 227 Bray Hall, 1 Forestry Drive, Syracuse, New York 13210 





Accessibility Report





		Filename: 

		Instructions for Completing a Thesis or Dissertation.pdf









		Report created by: 

		



		Organization: 

		







[Enter personal and organization information through the Preferences > Identity dialog.]



Summary



The checker found no problems in this document.





		Needs manual check: 2



		Passed manually: 0



		Failed manually: 0



		Skipped: 3



		Passed: 27



		Failed: 0







Detailed Report





		Document





		Rule Name		Status		Description



		Accessibility permission flag		Passed		Accessibility permission flag must be set



		Image-only PDF		Passed		Document is not image-only PDF



		Tagged PDF		Passed		Document is tagged PDF



		Logical Reading Order		Needs manual check		Document structure provides a logical reading order



		Primary language		Passed		Text language is specified



		Title		Passed		Document title is showing in title bar



		Bookmarks		Passed		Bookmarks are present in large documents



		Color contrast		Needs manual check		Document has appropriate color contrast



		Page Content





		Rule Name		Status		Description



		Tagged content		Passed		All page content is tagged



		Tagged annotations		Passed		All annotations are tagged



		Tab order		Passed		Tab order is consistent with structure order



		Character encoding		Passed		Reliable character encoding is provided



		Tagged multimedia		Passed		All multimedia objects are tagged



		Screen flicker		Passed		Page will not cause screen flicker



		Scripts		Passed		No inaccessible scripts



		Timed responses		Passed		Page does not require timed responses



		Navigation links		Passed		Navigation links are not repetitive



		Forms





		Rule Name		Status		Description



		Tagged form fields		Passed		All form fields are tagged



		Field descriptions		Passed		All form fields have description



		Alternate Text





		Rule Name		Status		Description



		Figures alternate text		Passed		Figures require alternate text



		Nested alternate text		Passed		Alternate text that will never be read



		Associated with content		Passed		Alternate text must be associated with some content



		Hides annotation		Passed		Alternate text should not hide annotation



		Other elements alternate text		Passed		Other elements that require alternate text



		Tables





		Rule Name		Status		Description



		Rows		Passed		TR must be a child of Table, THead, TBody, or TFoot



		TH and TD		Passed		TH and TD must be children of TR



		Headers		Skipped		Tables should have headers



		Regularity		Skipped		Tables must contain the same number of columns in each row and rows in each column



		Summary		Skipped		Tables must have a summary



		Lists





		Rule Name		Status		Description



		List items		Passed		LI must be a child of L



		Lbl and LBody		Passed		Lbl and LBody must be children of LI



		Headings





		Rule Name		Status		Description



		Appropriate nesting		Passed		Appropriate nesting










Back to Top



